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General usage 

Version 

The VELUX Energy and Indoor Climate 
Visualizer is available in two versions, the 
normal and a pro version. The normal version 
gives access to a range of predefined typical 
geometries whereas the pro version opens up 
for the possibility to change the size of a 
generic building or to import geometry from 
various file formats. Read more information 
about the two versions on the website: 
http://eic.velux.com. 

The version type can be found by selecting 
About EIC Visualizer from the Help menu. It 
will say ‘Pro’ or nothing. 

 

Figure 1 About dialogue 

Starting a new case 

A new case is created when you select New 
from the File menu. Several cases can be 
open at the same time. The open case 
windows are managed from the Window menu.  

Save 

You can save the current case by selecting 
Save from the File menu. You can also choose 
Save as… to save into a new file. 

Open 

Choose Open from the File menu to open an 
old case. Browse to the folder of your case and 
select the file. Finally click on the Open button. 

The most recent opened cases will be 
available in the File menu. 

Help and support 

Pressing F1 or choosing Help will open the 
User guide. The user guide will be opened 
automatically in the section corresponding to 
the tab, which is active when F1 is pressed. 

The About screen contains information on tool 
version and contact information about the 
VELUX EIC Visualizer team. 

For further technical information download the 
technical background document on the 
website.  

Automatic check for updates 

When the EIC Visualizer starts it automatically 
checks if an updated version is available from 
the EIC Visualizer server via the internet. If an 
update is available the user is asked if the 
update should be downloaded and installed. 
The use of a firewall might conflict with the 
automated update function. 

Keyboard shortcuts 

Ctrl + s: Save current file 

Ctrl + o: Open a project 

Ctrl + n: New project 

Ctrl + F4: Close active project 

http://eic.velux.com/
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Geometry 

This tab is active when a case is opened. Here 
the geometry and location of the building are 
specified. All input data fields have default 
values. When you change a value the 3D 
model is updated accordingly. 

The 3D model is a representation of the overall 
building geometry. The calculations include 
joints between walls, roof and floor even 
though they are not shown in the 3D-
representation. 

The colours are default and do not represent 
specific construction materials used. The 3D 
model shows a simple representation of 
window insertions. For roof windows the 
calculations are based on installation principles 
and lining configurations as recommended by 
VELUX. 

Building geometry 

Geometry Select one of the default house 
types: 

1-storey single-family house with open ceiling 

1-storey single-family house with flat ceiling 

1½-storey single-family house 

Roof space on apartment building 

End wall configuration Select if the house is 
free standing or part of a row of buildings. A 
house in a row will use less energy than a free 
standing house, because no energy is lost 
through the walls to the neighbouring 
buildings. 

If the building is defined as a row house or an 
attic, the neighbouring or underlying building 
will be presented by a transparent, brown 
shape.   

Size For each house, one of three default 
sizes can be selected. Internal measures are 
used, i.e. internal distances between walls.  

You should choose the geometry, which is 
closest to the actual building geometry you are 
evaluating. An irregular, e.g. L-shaped building 
can be evaluated with a rectangular EIC 
Visualizer model representation. The building 
size – closest to the specific design - should be 
selected. Remember to place windows with the 
correct orientation. 

The procedure will produce results, which are 
well-suited for comparing one case with 

Figure 2 Geometry tab 
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another, i.e. the addition of a window, even if 
there are differences between the geometry of 
the EIC Visualizer model and the actual 
building's geometry (as long as they have 
comparable net area). 

Alternatively, you can visit http://eic.velux.com 
and see how to get the full version where it is 
possible to change size and import geometry 
from various formats. 

Building geometry (pro 

version) 

Generic model 

Change the size of the generic model with the 
input boxes. All dimensions should be given as 
internal measurements. 

The ceiling can be either open or flat. If flat is 
chosen the roof windows will be modelled with 
light shafts with the same construction as the 
roof. 

The internal floor area is automatically 
calculated from the volume of the building. If a 
value is manually typed in, this value will 

override the calculated value. 

Imported model 

To import a model select the Import 3D model 
radio button and click the Import geometry 
button. On the dialogue browse to your 
geometry file and click open. 

The EIC Viz currently supports 3D Studio Max 
(3ds), AutoCAD 200X (dwg and dxf), Google 
SketchUp (skp), OBJ (obj) and VELUX 
Daylight Visualizer 2.5 exports (exp). See the 
3D guidelines for more details on how to 
create 3D models. 

Building location 

Location The location is the geographic 
location of the building. The list contains major 
cities from around the world and the most 
relevant should be selected. The selection 
ensures that the correct climatic data are used.  

Orientation The orientation of the building is 
selected. Major orientations can be selected 
from the list or a number can be entered. The 
orientation is indicated by the compass at the 
3D representation. 

Figure 3 Import geometry 

http://eic.velux.com/
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If another orientation is needed this can be 
made by choosing Degrees from north and 
typing the relevant orientation towards east. 

Country The country selection affects issues 
on country and regional levels: Currency, 
energy price and Energy Balance control 
schedule for solar shading.  

The selections of Country can be changed by 
pressing Country in the Building location box. 
This opens the Country dialog as seen in 
Figure 4. Here data for currency and energy 
price for the selected country are specified.  

This dialog is also where the Energy Balance© 
control schedule is selected. The Energy 
Balance control feature is available with all 
Integra© installed VELUX roller shutters and 
awning blinds. The control feature provides an 
energy optimised control of roller shutters and 
awning blinds for the climatic location of the 
building. It will activate the solar shading in 
daytime during summer and at night in the 
winter. This reduces the need for cooling in 
summer and the need for heating in winter. 
The Energy Balance feature is particularly 
relevant in warm climates. 

 

Figure 4 Country tab 

It is defined for major cities, and the city 
closest to the actual location of the project 
should be selected. If no relevant city is 
available, “None” should be selected.  

It is possible to define a new Country item, 
which will appear in the list of countries. This is 
done with the “Save as…” button. The country 
item will be saved with the current project, and 
will only be available within the current project.  
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Constructions 

Here the construction types of external walls, 
roof and floor are specified.  

When you change a value, the 3D model is 
updated to reflect the thickness of the selected 
construction type if wall thickness is turned on. 

Building envelope 

Any construction can be assigned to one of the 
four construction types. Click the desired 
construction to select it and choose the 
relevant construction type from the radio 
buttons. 

The lowest horizontal construction will 
automatically be assigned as floor, vertical 
constructions as walls and sloped 
constructions as roof. 

External wall construction The wall 
construction of the house is selected from the 
items on the list.  

Roof construction The roof construction of 
the house is selected from the items on the list.  

External floor construction The external floor 
construction of the house is selected from the 

items on the list. This is the floor at the lower 
boundary of the house.  

Adiabatic The adiabatic construction type is 
used to represent a construction facing a 
heated room, for instance the walls dividing a 
row house. There is assumed to be no heat 
loss through an adiabatic construction. 

Leakiness The leakiness of the house is 
selected from the items on the list. Choose the 
construction period, which is most 
representative for the project.  

Editing walls, roofs and floors  

It is possible for experienced users to edit the definition of 
walls, roof and floor. This is done by clicking the blue, 
underlined titles. Clicking a link opens a dialog as shown in 
Figure 6. In most situations, the standard construction 
items will be sufficient.  

The U-value and thickness of the construction are shown, 
as well as each individual layer of the construction. It is 
possible to change the thickness of each layer. When a 
value is changed, the construction U-value and thickness 
are updated.  

It is also possible to change materials or to add materials. 
Materials can be selected from the library of construction 
materials.  

Figure 5 Constructions tab 
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Figure 6 Dialog for editing walls, roofs or floors.  

The changed construction can be saved as a new 
construction type. The new construction will be saved in 
the current project, so it will not be available for other 
projects.  

Editing material properties 

Material properties can be edited. This will only be 
necessary in rare cases. The Material dialog is accessed 
from the dialog for editing construction types.  

 

Figure 7 Dialog for editing construction materials 

The heat conductivity, density and specific heat can be 
edited. The material can be assigned to a category.  

Press to edit 

material 
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Windows and doors 

Here windows, doors and openings are added 
and edited. When you add or change a value, 
the 3D model is updated to reflect the change 
and show the window or door. 

To add a new window or door, the “Add new 
window/door” button should be pressed. Then 
the properties of the new window, door or 
opening are selected, and finally the “Place” 
button is pressed. The new window, door or 
opening can then be placed in the model using 
the mouse. There is a visible 0.5 m x 0.5 m 
grid which the window snaps to.  

The windows, doors and openings installed in 
the house can be duplicated using the 3D 
view. A window is selected by clicking on it. 
The selected window/door is shown in blue 
and the coordinate system of the wall is 
shown, see Error! Reference source not 
found.. To copy the window, press the button 
“Add new window/door” followed by pressing 
the “Place” button.  

When a window is selected, the properties of When a window is selected, the properties of 
the window are shown in the fields to the left of 

the 3D view. It is possible to change properties 
at any time.  

It is not possible to select more than one 
window at the time.  

Window/door 

Type of window or door You can select a 
roof window, a facade window or a door. 

Window/Door The type of window or door is 
selected. 

Façade windows can be openable or not-
openable. Façade windows can have a 
ventilation flap (or grille) built into the frame.  

It is possible to define custom window types by 
choosing “Custom window/roof window”. With 
Custom window selected “Window/door” 
becomes clickable, which will open a dialogue 
where the properties can be edited. 

Custom window/roof window/door 

Values needed are the U-value of the frame (Uf), the 
widths of the frames and the linear transmission loss (Psi) 

Figure 8 Windows and doors tab 
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between window and roof. For roof windows the maximum 
opening area and effective height can also be edited. See 
the technical background document for more details on 
how this is done. 

Size The size of window or door is selected (or 
typed in for façade windows). 

Pane The pane type for the window or door is 
selected.  

It is possible to define custom pane types by 
choosing “Custom pane”. With Custom pane 
selected “Pane” becomes clickable, which will 
open a dialogue where the properties can be 
edited.  

Values needed are the g-value, tv, te, psi and U-value of 
the glazing. The U-value is needed for three slopes: 0°, 
45° and 90°. Values in between are interpolated from 
these. If accessories are to be used Fc, Ft, dUg of the 
products are needed. See more details on this in the 
technical background document. 

Accessories If the window is installed with 
solar shading, the solar shading is selected 
from the list.  

Openable for natural ventilation With this 
selection it is decided which windows will be 
used for natural ventilation. Windows, which 
are openable for natural ventilation, will be 
used for natural ventilation with the control 
options that can be selected at the Light and 
ventilation tab. Windows, which are not marked 
as openable for natural ventilation, will not be 
used for natural ventilation.  

All selected windows will be controlled with the 
same control options, so it is not possible to 
select different control options for different 
windows.  

Place When the “Place” button is pressed, the 
mouse can be used to decide where the 
window should be placed.  

Remove The “Remove” button is used to 
delete the selected window/door. 

Exact location The exact coordinates of the 
selected window are shown in the boxes. The 
location can be changed by changing the 
numbers if the window cannot be dragged with 
the mouse to the desired location. The 
coordinates are relative to the surface where 
the window is installed. 

Include natural ventilation extract 

duct or façade grill 

It is possible to add a natural ventilation extract 
ducts or façade grills. These can be selected 
from the Window/door dropdown and be 
placed and edited in the same way as windows 
and doors. The duct or grill will be open 
constantly, and the airflow through ducts will 
depend on the diameter and height above roof 
ridge of a duct or the width and height of a 
façade grill, and also on leakiness of the house 
and the distribution and control of windows for 
natural ventilation. 

Natural ventilation extract ducts and façade 
grills are common in bath rooms and kitchens. 

Extract duct 

Diameter The diameter of the duct.  

Height above roof ridge The distance from 
the roof ridge to the top of the duct. The lower 
end of the duct starts at the underside of the 
ceiling. The length of the duct is from the 
underside of the ceiling to the top of the duct.  

Façade grill 

Width and height The dimensions of the free 
opening area of the grill. This area is less than 
the actual hole in the wall and is the total area 
minus the area of the physical grill. 

Figure 9 A green rectangle indicates a location where the window can be placed. The red “no-drop” cursor indicates a window 
location, which is not valid 



Heating and cooling 

At this tab the controls for heating, cooling and 
solar shading are selected as well as the 
schedule for the occupants of the house. 

People 

Number of people The number of people 
occupying the house is selected.  

Schedule Here you can select when the 
occupants will be in the house by choosing the 
schedule, which best describes their 
occupancy of the house. The schedule can be 
edited by pressing Schedule. 

Edit schedule for the people occupying the house 

The schedules for occupancy can be edited by pressing 
Schedule, which opens the Schedule dialog. 

Where the blue curve is 1.0, all occupants are in the 
house. If there is nobody in the house, the curve should be 
0.0. It can be 0.5 if half of the occupants are at home.  

The blue curve is edited directly in the diagram by clicking 
and dragging parts of the curve. The schedule for 
weekdays, Saturdays and Sundays can be different 
depending on the checkbox selections. 

 

Figure 10 Dialog for editing occupancy schedule 

Heating and cooling system 

Heating set point The set point for the heating 
system. The heating system will attempt to 
maintain the specified temperature.  

Preferred max. summer temperature This 
input has two purposes and must always be 
specified: 

If a cooling system is present in the house, this 

Figure 11 Heating and cooling tab 
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is the set point for the cooling system. The 
cooling system will then attempt to maintain 
the specified temperature. 

The temperature is used for the night cooling 
control of natural ventilation.  

Cooling system present If “yes” is selected, a 
cooling system (air conditioner) is installed in 
the house.  

Solar shading, external and internal 

On when indoor temperature is above ___ 
°C If this control is activated, the shading is 
activated when the indoor temperature is 
above the set point and deactivated when the 
indoor temperature is below the set point. 

Automatic roof window control (These 
features apply only to the roof windows and 
will override the temperature control if active) 

VELUX ACTIVE Climate Control (sensor 
controlled) If this control is activated the solar 
shadings are controlled by sensors on the 
window. 

The VELUX ACTIVE Climate Control feature is 
available for all electrical products for both 
external and internal shading. 

It is an intelligent and self controlled shutter/ 
external solar shading. The external 
shutter/solar shading device is controlled by 
two wireless external sensors; One for 
measuring external temperature and one for 
measuring solar irradiation on the roof window. 
Based on input from the sensors, an intelligent 
algorithm has been developed for optimal 
control of the shutter/solar shading device. 

VELUX Energy Balance (time controlled) If 
this control is activated, the energy balance 
control strategy is used for roller shutters and 
awning blinds.  

The Energy Balance control feature is 
available with all Integra© installed VELUX 
roller shutters and awning blinds. The control 
feature provides an energy optimised control of 
roller shutters and awning blinds for the 
climatic location of the building. It will activate 
the solar shading in daytime during summer 
and at night in the winter. This reduces the 
need for cooling in summer and the need for 
heating in winter. The Energy balance feature 
is particularly relevant in warm climates. 

Advanced options 

Pressing this button opens options for 
electrical equipment, heating and cooling. 
Figure 12. 

 

 

Figure 12 Pressing the Advanced options buttons opens 
more options 

Electrical equipment 

Internal gains (electrical appliances) The 
internal gains are the electricity used by 
appliances, which are not part of the energy 
calculation. These are kitchen appliances, 
electronics, etc. The internal gains are not 
included in the energy demand of the building, 
but they are considered a “free gain”, which will 
reduce the heating demand of the building. 
Increasing the internal gains will reduce the 
heating demand of the building.  

It is difficult to make a precise estimate of the 
internal gains, but a value between 2 and 5 
W/m² will often be reasonable.  

Schedule The schedule for the gains can be 
edited if they are not the same during the day. 
They are edited as described for Figure 10. 

Heating system 

Energy source Here the energy source for the 
heating system is selected. These options are 
used for the results of energy costs. The 
energy source can be edited by pressing 
Energy source. 

 

Figure 13 Energy source dialog 



                     

VELUX Energy and Indoor Climate Visualizer 2.0 13/24 

Efficiency of heating system The efficiency 
of the heating system has an influence on the 
amount of fuel used. An electrical heating 
system is approximately 100% effective. The 
efficiency of an oil-burning boiler is lower, e.g. 
70%.  

Energy price per kWh (heating value of 
fuels) The energy price should be per kWh.  

Cooling system 

COP, coefficient of performance The COP of 
the cooling system should be inserted. 
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Light and ventilation 

At this tab the controls for lighting and 
ventilation are selected.  

Natural ventilation 

Windows marked as “openable for natural 
ventilation” are used as follows This control 
should be used when making calculations for 
buildings with natural ventilation. The windows, 
which have been marked as “openable for 
natural ventilation” on the Windows and doors 
tab, will be used with the controls below.  

Open windows when indoor temperature is 
above ___ °C Facade and roof windows are 
opened when the temperature is high. The 
specified temperature will be used as a set 
point so that the windows will start opening 1-
2°C before the set point is reached. The 
windows will not open all at once, but will 
“modulate” to maintain the set point. 

Will only be activated when people are present 
in the house, and if the outdoor temperature is 

less than 2°C above the indoor temperature. 
The last control prevents the building to be 
heated further if the outdoor temperature is 
warmer than indoors. This control option can 
be used to prevent overheating. 

Use windows for airing when outdoor 
temperature is above ___ °C for ___ 
minutes All windows are opened in the 
selected intervals at the selected times of day. 
Roof windows are opened approx. 21 cm 
(corresponding to the max. opening of an 
electrical Integra window). Façade windows 
are opened 10% for window height above 1,5 
m, and 20% for window heights below 1,5.  
Airings are only made when people are 
present in the house. This control option can 
be used to refresh the air in the house and is 
recommended in cold climates to reduce 
moisture problems.  

The temperature set point can be used if 
ventilation is considered undesirable on very 

Figure 14 Light and ventilation tab 
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cold days.  

Morning, midday and evening is defined as 
follows:  

Morning: 6:00 

Midday: 12:00 

Evening: 20:00 

Use ventilation flaps for background 
ventilation when outdoor temperature is 
above ___ °C With this control option the 
ventilation flaps of all windows (not only those 
marked as “openable”) are kept open all year 
to supply background ventilation. It is 
recommended to use this option to provide a 
healthy indoor environment. The temperature 
set point can be used if background ventilation 
is considered undesirable on very cold days.  

Use windows for night cooling All 
“openable” roof windows open between 22:00 
and 7:00 if the indoor temperature at 22:00 is 
above the average of the heating set point and 
the preferred maximum summer temperature, 
and if the outdoor temperature is below the 
indoor temperature. This control option is 
relevant in warm climates to cool the building 
during the night.  

Constant natural ventilation all year at ___ 
[ACH]. This control option should generally not 
be used. It does not reflect how natural 
ventilation works in real buildings. It is included 
in the EIC Visualizer for comparison with other 
simulation tools, which use a constant natural 
ventilation rate. When this control is selected, 
infiltration from leakiness through cracks in the 
building is not included.  

Mechanical ventilation 

Mechanical ventilation is installed If this is 
activated, mechanical ventilation is considered 
active. Mechanical ventilation is considered on 
24 hours a day in the part of the year selected 
below.  

Type of mechanical ventilation Choose 
between two types of mechanical ventilation:  

Balanced ventilation with heat recovery.  
The airflow rate in ACH should be entered as a 
number.  
The heat recovery efficiency should be 
selected among three options (high (85%), 
medium (75%), low (65%)) 

Extract ventilation without heat recovery. 
The airflow rate in ACH should be entered as a 
number. 

Mechanical ventilation is used 
summer/winter If the mechanical ventilation 
system is on all year, both summer and winter 
should be activated.  

The period for summer and winter is based on 
the Energy Balance control in the Country 
dialog. Some weeks are not included in the 
energy balance definition. When summer or 
winter is selected alone, the weeks of the 
Energy Balance definition is used.  

Advanced options 

Pressing this button opens options for 
electrical equipment, heating and cooling.  

 

 

 

Figure 15 Pressing the Advanced options buttons opens 
more options 

Electrical lighting 

Type of electrical lighting The lighting can be 
selected from three types: Typical, Only 
fluorescent and Only Incandescent. Typical is 
an equal mix of fluorescent and incandescent 
lighting.  

Incandescent lighting uses more electricity, but 
has a better colour representation than 
fluorescent lighting.  

Each type of lighting can be combined with a 
set point. When the daylight level is below this 
level, the electrical lighting will be in use if 
there are people occupying the house who are 
not sleeping. People are considered to be 
sleeping between 23:00 at night and 7:00 in 
the morning.  

The electrical lighting is controlled by using 
“dimming”, which means that the electrical 
lighting is only on at 100% if there is no 
daylight at all. 

The options for electric lighting can be edited 
by pressing Type of electric lighting. This 
opens the dialog of Figure 16. 
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Figure 16 Dialog for electric lighting options 

Installed electrical lighting power The 
default values of installed power can be edited. 
The values are in W/m².  

Percentage of lighting on simultaneously 
All light may not be on simultaneously in a 
house. If only 50% of the rooms have the light 
switched on at the same time, this is typed in 
here.  

Off when the average daylight level is 
above ___ lux Here the set point for electrical 
light should be entered.  

If a new combination of options is created, a 
new lighting item can be saved under a new 
name using “Save as…”.  
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Start simulation 

At this tab the simulation is described and 
started, and advanced results can be selected.  

 

This button opens the Description dialog where 
information about the project can be entered. 
The information will be included in the results 
report.  

 

Figure 18 Description dialog 

 

Select advanced results 

 

This button reveals the advanced results, 
which can be logged during the simulation. 
The options selected here have no influence 
on the results report. The options only have an 
influence on which advanced results will be 
available after simulation for analysis by 
experienced users.  

All options can be selected, but some of the 
options will generate large data files (more 
than 10 MB). 

 

Pressing the “Start simulation” button will start 
the simulation.  

 

 

Figure 17 Start simulation tab 
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If more than one model should be simulated, 
the “Simulate all open models” button can be 
used. Pressing this button will start the 
simulation of all models which are open in the 
program window one after another.  

While the simulation is running, a simulation 
progress window will be visible. The date at the 
top-right corner shows the progress during the 
year. During the simulation, the indoor and 
outdoor temperatures are shown on a scale 
from -10°C to 30°C and the ventilation rate of 
the building is shown on a scale from 0 to 5 
ACH.  

 

Figure 19 Simulation progress window 
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Results 

At this tab results are selected and viewed.  

Generate report 

The results reports are printable reports, which 
contain the main results of the simulation. The 
reports cover the needs of most users. The 
contents can be customised.  

 

When this button is pressed, a report is 
generated with results on the model. 

In the top right corner a menu is show where 
additional results can be turned on and off. 
The menu can be hidden if it interferes with the 
content. 

The report is an HTML file, which can be 
printed and saved from the file menu. The 
“Save” function will only save the text and not 
the diagrams, so it is recommended to print the 
report to a PDF conversion utility. Choose 
“Print” from the file menu, and select a pdf 

printer. See the report help for more 
information. 

 

 

 

  

 

Figure 20 Results tab 
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Pressing this button creates a report which 
compares the results of all the models which 
are open in the EIC Visualizer. Several models 
can be open at the same time in the EIC 
Visualizer, and this function is used to compare 
variants of the same building, e.g. a base case 
and a case with added windows or solar 
shading.  

The report can be changed, printed and saved 
following the same principles as the single 
report. 

 

When this button is activated it is possible to 
animate the operative temperature and 
compare it to the comfort range and other 
simulation results. Each open project will 
automatically be compared to the active 
project. 

The comfort range is based on the active 
model and is calculated on the basis of the 
outdoor temperature, according to the 
European Standard EN15251. The outdoor 
temperature is also shown. 

Important note: If models with different 
climate or models with and without mechanical 
cooling are compared the comfort ranges only 
apply to the active project. The comfort range 
is based on the outdoor air temperature and 
the presence of a cooling system. 

 

The graph show the temperatures and comfort 
range for either one day or one week. 

Under advanced results the comfort range 
(class I, II and III), outdoor temperature 
together with the operative temperature of the 
open projects can be seen for the entire year. 

 

 

When this button is activated, it is possible to 
make an animation of the ventilation flows 
through windows and the current energy 
balance of the windows. 

 

Ventilation flows  

Arrows show when there is a flow through 
individual windows. The size and colour of the 
arrow represents the magnitude of the airflow 
in l/s.  

There can be two airflows through each 
window. This represents how pivoting roof 
windows work, but also applies to other types 
of windows. The airflow can in the same 
direction at the lower and upper part, but can 
also be in opposite directions.  

The airflows take into consideration that there 
is infiltration in the building (air entering 
through leakages in the façade). Due to the 
stack effect, it is common that air will enter the 
house through façade windows and be 
extracted through roof windows. 
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Current window energy balance 

Arrows show the energy flow in and out 
through individual windows. The size and the 
colour represent the magnitude of the energy 
flow. The arrow with two arrow heads shows 
the solar gain and the arrow with one 
arrowhead show the transmission loss. The 
transmission loss can be in both directions. 

The energy flow is visualized for each window 
for each time step. This shall not be compared 
with energy balance equations for a whole 
year. 

Animation settings 

It is possible to change the start and end time 
of the simulation. This can be used to 
investigate a typical summer, winter or spring 
day, for example. The animation speed can 
also be adjusted. The higher the number in 
hours per second, the faster the animation will 
run.  

Scale bar: Max. This option can be used to 
adjust the scale of the arrows. The maximum is 
automatically assigned to the highest airflow or 
energy flow occurring during the animation, but 

this can be much higher than the typical 
values. It will often be helpful to reduce the 
maximum to 50 l/s or less for ventilation. For 
the current energy balance animation the 
maximum value should be adjusted according 
to the season in focus. 

Show advanced results 

Here experienced users can select detailed 
results to analyse specific issues.  

 

 

Figure 21 Visualisation of ventilation flows 
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Each advanced result will open a diagram. 
This can be changed to a table view using the 
tabs at the top of the results window.  

The arrows at the bottom of the results window 
can be used to change from annual to for 
example monthly results. 

The energy balance for each window in a 
project can be found in “Energy performance 
of building – including individual windows”. For 
each window there is a column titled QSOLAR 
and a column titled QTRANSM. QSOLAR is 
the heat gain, and QTRANSM is the 
transmission. QTRANSM will be negative 
during the winter season. On warm summer 
days it can be positive, when the outdoor 
temperature is above the indoor temperature. 

Data can be exported directly to Excel via the 
logo at the bottom right corner. The standard 
exported values uses the time steps used in 
the calculations. To get for instance hourly 
values use the table pane and change the 
table properties to hourly values. Then copy 
the data manually into Excel. This method, 
however, will export the hourly mean values of 
the preceding hour. More details on this issue 
are found in the technical background 
document. 

 

Figure 22 Advanced results 



                     

VELUX Energy and Indoor Climate Visualizer 2.0 23/24 

Using the 3D view 

The geometry of the building is shown in the 
3D view to the right with solid walls showing 
the wall construction. A compass is shown to 
keep track of the building orientation. The 3D 
model can be interactively rotated, zoomed 
and panned. 

Figure 24 

Descriptions of buttons: 

Turn on/off thickness This button will turn on 
or off the thickness of the constructions. 

Restore default view This buttons resets the 
section view and displays the full building. 

x+ Cut 3D model along the x-axis removing all 
geometry on the positive side of the cut plane. 

x- Cut 3D model along the x-axis removing all 
geometry on the negative side of the cut plane. 

y+ Cut 3D model along the y-axis removing all 
geometry on the positive side of the cut plane. 

y- Cut 3D model along the y-axis removing all 
geometry on the negative side of the cut plane. 

z+ Cut 3D model along the z-axis removing all 
geometry on the positive side of the cut plane. 

z- Cut 3D model along the z-axis removing all 
geometry on the negative side of the cut plane. 

Description of mouse operations: 

Left mouse button: Click Select object. 
Selected object is shown in blue. 

Left mouse button: Hold down and move 
mouse Rotate the model. The model is always 
oriented so that the positive z-axis is upwards. 

Left mouse button: At cut, press Ctrl-key, click 
within red frame, hold down and move mouse 
Move the cut plane. 

Middle mouse button (or both the left and the 
right mouse buttons on a two-button mouse): 
Hold down and move the mouse Move the 
model up, down, right or left. 

Figure 23 3D view 
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Right mouse button: Click Open right mouse 
button menu. 

Right mouse button: Hold down and move 
the mouse Zoom in/zoom out. Move the 
mouse upwards to zoom in and downwards to 
zoom out. 

Right mouse button menu: Set focus Set the 
point around which the model is rotated and 
towards which it is zoomed (Hotkey F). 

Right mouse button menu: Zoom extends 
Zoom and pan the model so that the entire 
model is visible (Hotkey R). 


